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October is Domestic Violence 
Awareness Month and Breast 
Cancer Awareness Month. 
Check out how to get involved 
in events supporting these 
causes.  See “Take Action in 
October,” on the front page. 

Support Domestic Violence 
Awareness Month by wearing 
black every Thursday this 
month. Check out other events 
sponsored by the Women’s 
Center, as well. See Calendar, 
page 2. 

Oxygen is looking for women 
leaders like you! See how to 
attend a panel discussion that 
explores the basics of public 
speaking and how to attract 
positive media for you and your 
cause.  See page. 4 

Welcome the new VAWPP    
Coordinator, Lorraine Trippodi!  
Find out about VAWPP  
programs going on in October, 
and how you can become a 
peer educator. Check out 
VAWPP Corner, page 5. 

Check out how to subscribe to 
the Women’s Center listserv, 
which provides weekly updates 
on news and events that  
concern women.  Also, see how 
you can contribute to our  
newsletter.  See page 5. t

            “Man may have discovered fire, but 
women discovered how to play with it," 
says Sarah Jessica Parker’s character  
Carrie in one episode of the hit HBO  
series “Sex and the City.” Sassy lines such 
as these are what keep viewers coming 
back for more as Carrie and friends dish 
about shoes, jobs, parties, and, most of 
all, their weekly sexual conquests. The 
show has received critical acclaim for its 
smart writing and unique characters. 
These women are so special, say many 
fans, because of their carefree, single-girl 
attitudes.   
     Successful in their respective profes-

(“Empowerment," Continued on page 3) 

Empowerment, “Sex 
and the City” Style 

 
By Jennifer Dixon 

     When you think of October,  
pumpkins, witches and ghosts may spring 
to mind.  However, this month, focus 
your thoughts on becoming involved in 
two causes that cannot be ignored.   
October is designated as both Domestic 
Violence Awareness Month and Breast 
Cancer Awareness Month, two issues of 
extreme concern to women of all ages. 
     Nearly one in three U.S. women  
report being abused by a boyfriend/
partner at some point in their lives.   
According to the U.S. Department of  
Justice, a woman is raped every two  
minutes.   
     Colleges, which were once perceived 
to be areas of safety where few crimes 
were committed, have come to the  
forefront of the violence against women 
issue.   
     In a study entitled, The Sexual  
Victimization of College Women 
(www.ncjrs.org), Bonnie S. Fisher states 
that colleges are hotbeds for sexual as-
saults against women.  She estimates that 
350 rapes occur every year at colleges 
with 10,000 female students.  
     According to the U.S. Department of 
Justice, young women between the ages 
of 16 and 24 experience the highest rates 
of violence by current or former intimate 
partners.   
     Once a woman has been abused in a 
relationship, her chances for being 
abused again increase.  Therefore, college 
relationships can start a cycle of violence 
to be repeated in future relationships. 
    You can join the Women’s Center in 
acknowledging domestic violence this 
month and become informed by  
attending events sponsored by the  
Violence Against Women Prevention 

Program.  Thursdays in Black, a campaign to 
raise awareness about abuse in intimate 
relationships, encourages all students,  
faculty and staff at UConn to wear black 
every Thursday in October.   
     Also sponsored by VAWPP, are When 
Love Hurts, and Hatred in the Hallways.  
When Love Hurts features Donna Ferrato, 
an internationally acclaimed photographer 
who has been documenting the lives of 
abusive couples for  more than 10 years.  
She will present a slide show portraying 
the lives of abusers and their victims.   
     Widney Brown, will speak about her 
work on the Hatred in the Hallways 
Report, which studies the impact that fear 
of homophobia has on the violence  

(“Action” continued on page 4) 

Take Action in October 
By Joy Pachla 
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October 
Domestic Violence Awareness Month; Breast Cancer Awareness Month 

Thursdays in Black 
Thursdays in Black is a campaign to raise awareness about abuse in relationships.  Students, faculty, and staff are asked 
to wear black to acknowledge the impact that relationship violence has on our community - the emotional and physical 
suffering it causes our friends, relatives, colleagues and neighbors.  Buttons, stickers, and information will be handed 
out every Thursday in October in the Student Union Lobby from 10 a.m. - 4 p.m.   
Please join us in wearing black every Thursday this month. 
 
3rd:  When Love Hurts 
Photographer Donna Ferrato has been documenting the lives of individuals and couples suffering relationship abuse 
for more than 10 years.  She will share her moving slide presentation portraying the reality of people’s lives, which 
gives the audience a deeper, more personal understanding of domestic violence in America. 
Wednesday, 7 p.m., Von der Mehden Auditorium 
 
4th:  Plenary Address: Who’s Qualified with Lani Guinier   
Part of The Institute for African American Studies Critical Issues Series. 
Dr. Guinier is a Professor of Law at the Harvard Law School and the author of The Tyranny of Majority: Fundamental 
Fairness in Representative Democracy and Who’s Qualified. 
Thursday, 2 p.m., Rome Commons Ballroom, South Campus 
 
10th:  Human Rights and the Asian American Community with Helen Zia 
Ms. Zia is a journalist, activist and the author of Asian American Dreams: The Emergence of a People. 
Wednesday, 4:30 p.m., Rome Commons Ballroom, South Campus 
 
17th:  The Poor People’s Campaign for Economic Human Rights with Cheri Honkala  
Ms. Honkala is the founder and Executive Director of the Philadelphia-based Kensington Welfare Rights Union.  She 
will be sharing her experiences as the grassroots leader of this multi-racial, multi-ethnic, economic justice group and 
her own journey as a single mother and former homeless welfare recipient to a nationally recognized leader in the 
struggle against poverty in the United States. 
Wednesday, 4 p.m.,  Konover Auditorium, Thomas J. Dodd Research Center 
 
18th:  Thursday Night at the Movies - Hate Across America 
From the KKK to the more savvy and subtle groups active today, this is a comprehensive look at hate crimes in  
America. 
Thursday, 6:30 p.m., Women’s Center Lounge. 
 
23rd:  Hatred in the Hallways with Widney Brown 
Ms. Brown is the Advocacy Director of the Women’s Rights Division of Human Rights Watch and co-author of the 
Hatred in the Hallways Report. This report focuses on the impact that homophobia and fear of “not being manly enough” 
had on the numerous school shootings in recent months/years.  The report identified such incidents of school  
violence as gender-based violence, committed almost exclusively by boys against ex-girlfriends, girls who they were  
obsessed with/stalking, and/or peers who had taunted them for not being masculine enough. 
Tuesday, 7 p.m., Student Union Ballroom 
 
29th:  Reception with Kim Gandy, President, National Organization for Women 
Monday, 2 - 4 p.m., Rome Commons Ballroom, South Campus. Reserved seating only! 
Call the Women’s Center for information and to register. 
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sions, the “Sex and the City” girls cruise from relationship 
to relationship looking for, in some cases, a prospective 
husband, and in others, simple sexual satisfaction. These 
women, it has been said, are impressive examples of the 
woman of the new millennium. This is today’s version of 
female empowerment.  
 Was this, the power to shop all day for Jimmy 
Choo stilettos and sleep with whomever we choose then 
gab about it afterwards, the empowerment that the  
feminists of the past worked so hard to achieve? While the 
 sexual freedom of the characters in “Sex and the City” is 
relatively unique amongst women on television, who are 
very often only there to dote on a show’s male protagonist, 
the notion of passing this off as “empowering” is rather 
disturbing. The idea of economic freedom as evidence that 
feminism has reached its climax is one of the reasons that 
the feminist movement has lost so much momentum.  
     It is easy to point fingers and claim that the lack of 
popular support for a modern feminist movement is the 
fault of middle-class white women and their general  
contentment with their status in modern American society. 
The very nature of feminism, however, has made it  
susceptible to this loss of momentum. The movement has 
always been multifaceted, and the number of different 
groups, each working for its own issues, has made it  
difficult for feminists to present a united front. The prob-
lem is made even more complex in modern society where 
the obstacles that women face are less obvious to the  
general American population. Women have the vote. Title 
IX and similar acts have decreased the amount of blatant 
sex-based discrimination, even though the problem still 
exists. For many middle class women, the problem seems 
to be “solved.”  
     However, the economic empowerment that has led to 
"Sex and the City" style contentment for some women is 
not representative of the success of the women's move-
ment as a whole - it is only a very small portion of what is 
yet to be achieved. The feminist goal of women becoming 
strong citizens by gaining responsibilities and freedoms 
equal to those of men has somehow, in today’s consumer 
culture, translated into the theory of purchasing power as 
the route to empowerment. The same middle class discon-
tent that Betty Friedan explored in The Feminine Mystique 
seems as though it will inevitably resurface as more women 
realize that consumerism and the economic power that 
comes with it, which were once thought to be the solution 
are, in truth, the problem. Happiness, represented today by 
the freedom to shop and spend, and empowerment, the 
true goal of the feminist movement, are not one and the 
same. This realization will be the most important step  
towards redefining the modern definition of feminism and 
forming a united feminist majority; two goals that have  
remained elusive to modern women for some time.  

(“Empowerment,” Continued from page 1)      The growing trend of women utilizing their sexuality as 
a weapon and tool for getting what they want is well repre-
sented by “Sex and the City” and celebrities such as Brit-
ney Spears and Anna Kournikova. The attitude behind this 
trend is one of taking charge: women have been exploited 
by men for so long, that it is a step up for women to be 
exploiting themselves. Something incredibly degrading has 
miraculously disguised itself as a new form of empower-
ment. It is astounding that a movement once so opposed 
to consumer culture has managed to become integrated 
into the media and has, for many young women raised in 
this culture, lost its meaning. The feminist movement does 
not belong solely to the middle class white women that it 
has done so much for - if the movement is to survive and 
thrive in modern society, it’s most important issues will be 
ones not embraced by mass American culture.  
     “Sex and the City,” shopping, and sex appeal may be 
fun, but they are not as good as it gets, and it will not be 
until women begin to challenge the status quo and refuse 
to remain “comfortable” that they will realize how much 
can really be achieved. Modern society, in which many 
women believe that exploitation, by themselves or by  
others, is a necessary evil, and that sexism is a “fact of life” 
leaves much to be desired. An equal playing field, in which 
sex and power are not interrelated, is yet to be achieved. 
The glass ceiling still exists. If the privileged, upper middle 
class women have so far to go and so much to achieve, the 
status of other groups are far worse. Poor women, women 
of color, lesbian women, and women in countries far  
removed from the insulated, “enlightened” western world 
that we live in face severe discrimination and abuse  
everyday that many Americans are completely unaware of.  
     What, then, is the "new frontier" of feminism? A sec-
ond try for the ERA, gay rights, birth control and abortion 
issues, international human rights offenses, the wage gap, 
and sexual abuse are only the most publicized issues that 
women face today. The most important thing is that young 
women take up feminism as a cause worth fighting for, 
presenting a united front and realizing that women’s issues 
are relevant to all women - not just the certain minorities 
that may be affected by them most directly. Some issues, 
such as gay rights and international human rights offenses, 
may not be as immediate and close to home as those of the 
past, but this makes them no less important, and a united 
feminist majority would allow the voices of oppressed 
women to be heard. The future leaders of the movement 
who are yet to appear will be powerful, intelligent women 
aware of the current state of women’s issues, and prepared 
to initiate a shift in the climate of American society’s exces-
sive consumerism. Their most important tasks will be to 
redefine the movement as well as rework the modern  
definition of female empowerment, shifting it from the 
media- based sexual and economic power of today towards 
the empowerment of all women as worthwhile citizens.   
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Oxygen Media is looking 
for leaders like you! 

Oxygen, a cable television network and Internet site 
for women, (co-founded by Oprah Winfrey), and 
AT&T Broadband recently launched the Oxygen 
Media Choose to Lead campaign, an on-air, online 
and grassroots initiative to increase the number of 
women serving in representative leadership  
positions - from the PTA to the state legislature.  
 
To get involved with Choose to Lead, you can:  
• Log on to www.oxygen.com/choosetolead 

to enter a scholarship contest to attend  
      leadership training at the Women's Campaign   
      School at Yale or the Woodhull Institute.  
 
• Register to attend a free leadership seminar, 

How to Speak to the Public and Make the 
Media Your Friend, on October 20, 2001 at 9:00 
a.m. at the Old State House. Christine Jahnke, 
President of Positive Communications in  

      Washington, D.C.,  Dianne Wildman, the  
       Director of Editorial Services at Cablevision,      
       Lieutenant Governor Jodi Rell and State  
       Comptroller Nancy Wyman will all speak at the   
       seminar . This event is free of charge and open  
       to the public, but participants need to reserve a  
       seat by calling 888-824-8355.  
 
• Look for Choose to Lead public service  
      announcements, on the Oxygen network,  
       featuring Connecticut Lieutenant Governor 
       Jodi Rell and New London school board 
       member Tammie Clayton.  
 For more information visit the Oxygen website at: 

 www.oxygen.com/choosetolead.  

Women’s Center Diversity 
Committee 

     The Women’s Center Diversity Committee, a sub 
committee of the Women’s Center Advisory Board, 
provides programming and networking opportunities 
for faculty and staff, women of color.  This committee 
has been in existence for three years and has sponsored 
three successful programs.  There have been two 
luncheons and a recognition banquet that took place 
last May.  At the banquet, four women were recognized 
for their outstanding commitment to the campus  
community.  This fall the committee will be putting  
together a resource guide that will have a list of  
different restaurants, hair salons and more for our  
targeted group of women.  The Diversity Committee 
will host its third luncheon on Nov. 14, 2001.  In the 
spring we will recognize another group of women for 
their contributions to the campus community at our 
second recognition banquet. 

committed in schools. 
     For more information about these events, please see 
the calendar on pg. 2.     
     Chances are if you are not affected by breast cancer 
in your own life, you know someone who is.  It is  
estimated that 192,000 new cases of invasive breast 
cancer will be diagnosed in 2001, (American Cancer 
Society, www.cancer.org).  
     On Oct. 14, Hartford will host its 7th Annual  
Making Strides Against Breast Cancer Walk.  The walk 
raises awareness and funds to find a cure.  At last year’s 
walk, $523,000 was raised.   
     For information on how to participate in the walk 
visit www.cancer.org.   

(“Action” continued from page 1) 

Women’s Fall Sports  
October Home Game Schedules 

Field Hockey 

10/3:   Providence            7 p.m. 

10/6:   Old Dominion       Noon  

10/10: Boston College       7 p.m.  

10/19: Boston University   7 p.m. 

10/24: Fairfield                  4 p.m.  

Volleyball 
10/5:   Syracuse                   7 p.m. 

10/7:   Notre Dame             2 p.m. 

10/20: Manhattan College    2 p.m. 

10/24: Fordham University  7:30 p.m. 

10/26: Seton Hall                 4:30 p.m. 

10/28: St. John’s                   2 p.m.  

Soccer 

10/5:    Syracuse          7 p.m. 

10/19:  Pittsburgh        7 p.m. 

10/21:  Notre Dame     1 p.m. 

10/24:  Harvard            7 p.m. 

11/1:    Yale                  7 p.m. 
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Join Our Listserv! 
     Want to keep up with the Women’s Center on a 
weekly basis?  Then join the U-WOMEN Listserv, 
a weekly updated e-mail featuring events at the 
Women’s Center, on and off campus events,  
announcements and national/international news.  
To subscribe: please go to http://vm.uconn.edu/
subunsub.html. You must have a valid e-mail to 
join. Fill in the appropriate information.  For list 
name, type “UWOMEN-L.”  If you have prob-
lems, please e-mail Kathleen Holgerson at 
wctadm03@uconnvm.uconn.edu. 
 
Lesbian Expressions 
     A support group for lesbians, bisexual women 
and women questioning their sexuality.  It meets 
every Wednesday evening at 7 p.m. in the 
Women’s Center lounge.   
 
Contribute! 
     If you have any ideas for columns or articles or 
would like to submit a piece to our newsletter, 
please feel free to contact the editor, Joy Pachla, by 
e-mail at: joypachla@hotmail.com, or call the 
Women’s Center and leave a message.  All  
contributions are greatly appreciated!  
 

VAWPP Corner 
VAWPP Welcomes New Coordinator 

 
By Jessica K. Giordani 

 
     The Women’s Center is happy to welcome Lorraine  
Trippodi, the new coordinator of the Violence Against 
Women Prevention Program! Lorraine began her work here 
in March and is enthusiastic about expanding the program 
further into the UConn community. While an undergraduate 
at the University of Rhode Island, Lorraine helped to institute 
their Violence and Sexual Assault Prevention Program as a 
reaction to the many sexual assaults that occurred on campus. 
Her activism continued during her graduate studies at CCSU 
where she was the graduate assistant at the Women’s Center 
on campus. Now at UConn, Lorraine is teaching WS 271: 
Rape Awareness Seminar I and WS 272: Rape Awareness 
Seminar II, which is offered in the spring semester. As  
coordinator of VAWPP, Lorraine wants to make sure that 
“all students understand the roots of violence against women 
and what is acceptable and unacceptable behavior.” 
 As we all know, October is Domestic Violence 
Awareness Month, and Lorraine will be busy keeping the 
VAWPP involved with events such as, Thursdays in Black, 
When Love Hurts and Hatred in the Hallways (see the calendar on 
pg. 2 for more information on these events). VAWPP is  
currently planning to develop some new programs related to 
the topics currently covered (sexual assault and consent,  
dating violence, media images, and social attitudes about 
women, etc.) and update the programs currently being  

        offered.  “[We] want to develop new ways of present-
ing the information so that students who may have seen 
a program two years ago can hear the message again in a 
new way…with new material and updated scenarios, the  

        presentations can be more relevant and reach more  
people.” 

      The MAVAW (Men Against Violence Against 
Women) program has recruited a group of male  

        students who have begun training to become peer  
        educators. “The idea behind the MAVAW program 

and others like it is that it helps men to recognize and 
accept their responsibility in preventing sexual assault 
because the message is coming from other men…They 
can feel more understood and therefore be more willing 
to listen and examine their attitudes.” The program is 
expected to start by the end of October. 

       The VAWPP and MAVAW programs are still  
        looking to train students to be peer educators.  Any-

one interested should contact Lorraine Trippodi at 486-
4738, or stop by the Women’s Center to see her.  

Carol Millette 
Administrative Assistant 

 
Phone:  860-486-4738 

TDD:  860-486-1546                  Fax:  860-486-1104 
 

Email:  wwwwctr@uconnvm.uconn.edu 
 

Semester Hours:  M-Th:  8 a.m. - 8 p.m. 
                                & F:  8 a.m. - 5 p.m. 
Website: www.womenscenter.uconn.edu 

Some Reminders... 

Kathleen Holgerson 
Director 

 
Kathy Fluckiger 

Associate Director 

Joy Pachla 
Editor 

 
Lorraine Trippodi 

VAWPP Coordinator 
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A Guide to Creating 
 the Women’s Center 

 Newsletter 
 Using 

 Microsoft Publisher 

By Joy Pachla 



Before you start creating your newsletter, you have to know how to use the tools.  In this  
section, we will take a look at the tools you’ll use in Publisher and how they will help you.   
Becoming familiar with the tools will provide shortcuts along the way. 
 
Starting with the Object Toolbar on the left side of the screen:   
 

  
 

  
        

  
    

   
  

A 
Text  Frame  Tool:  This tool allows you to put text on the page.  Before you can put any 
kind of text on the page you need to create a box or rectangle with this tool.     

Table  Frame  Tool:   
This tool will allow you to create tables. 

Word Art  Frame  Tool:  By using this tool you can modify letters by stretching,  
slanting, curving, inflating and more.  

Picture  Frame  Tool:   
With this tool you can insert pictures that you have saved in a file. 

Clip  Gallery  Tool:  This tool allows you to import pictures from the clip art gallery into 
the newsletter.  You can import cartoons, symbols, borders and much more. 

Line  Tool: This tool is used for drawing lines.  Lines work well to separate the text of  
different articles or headlines from articles.  Lines help break up the page. 

Oval  Tool:  Use this tool to create circles and ovals.  To make a perfect circle, hold 
down the Shift button while creating the object. 

Rectangle  Tool:  This tool creates squares and rectangles.  To create a perfect square, 
hold down the Shift button when you are creating the object. 

Custom  Shapes  Tool:  This too allows you to create different shapes, other than a 
square, rectangle or circle, such as a star, heart, or triangle.   

The four tools that remain on the Object Toolbar, the Hot Spot Tool, the Form Control Tool, 
the HTML Code Fragment Tool and the Design Gallery Object Tool are rarely used, and you 
will probably not use them for creating this newsletter.  However, if you want to find out about 
them, look under Microsoft Help.   

Getting to Know the Tools: 

Page 2  
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The  Women’s  Center  Newsletter 

The title is in the  
Garamond font.  In 
order to spread the 

title out, go to Format 
and select Character 
Spacing, which can 
expand or condense 
the letters in a word. 

To make this space gray, you must 
fill both the text frame and the  

regular box with the color.  To do 
this, click on the box you want to 
fill, go to Format and select Fill 

Color.  You can choose from 
many colors. 

In order to write text, 
such as the title, you  

have to create a text box 
with the Text Frame Tool 

first. 

By making a rectangle with 
the Rectangle Tool, it creates 
a nice border around the title. 

By using the  
Rectangle Tool,  

borders are  
created around 
the newsletter.  

You can use the  
Line/Border/
Style Tool to 

created different 
widths for the 

borders.  

Empowerment ,  “Sex and the City” Sty le  

 Domestic Violence Awareness Month 
     By Joy Pachla 

     When you think of October, 
pumpkins, witches and ghosts 
may spring to mind.  However, 
this month, focus your thoughts 
on becoming involved in two 
causes that cannot be ignored.   
     October is designated as both 
Domestic Violence Awareness 
Month and Breast Cancer 
Awareness Month, two issues of 
extreme concern to women of all 
ages. 
     Nearly one in three U.S. 
women report being abused by a 

boyfriend/partner at some point 
in their lives.   
     According to the U.S. 
Department of Justice, a woman 
is raped every two minutes.   
     Colleges, which were once 
perceived to be areas of safety 
where few crimes were commit-
ted, have come to the  
forefront of the violence against 
women issue.   
     In a study entitled, The Sexual 
Victimization of College Women 
(www.ncjrs.org), Bonnie S. Fisher 
states that colleges are hotbeds 

for sexual assaults against 
women.  She estimates that 350 
rapes occur every year at colleges 
with 10,000 female students.  
     According to the U.S. 
Department of Justice, young 
women between the ages of 16 
and 24 experience the highest 
rates of violence by current or 
former intimate partners.   
     Once a woman has been 
abused in a relationship, her 
chances for being abused again 
increase.  Therefore, college 
relationships can start a cycle of 

In order to make more 
than one column in a text 
frame, click on the text 
frame, go to Format and 

select Text Frame  
Properties.  Under  
Columns, type the  

number of columns you 
want. 
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In order to have 
the text show up 

in a black  
background go to 

the Font Color 
Tool and select 

White. 

A headline should have a 
unique font, but try to 

maintain only one or two 
headline fonts throughout 

the publication.  Too 
many different headline 
fonts will break up the 
unity of the newsletter.  

You should use the same 
font for the text of articles 
throughout the newsletter. 

October is Domestic 
Violence Awareness 
Month and Breast 
Cancer Awareness 
Month. See front page.  

Support Domestic 
Violence Awareness 
Month by wearing black 
every Thursday this 
month. See  page 2. 

Oxygen is looking for 
women leaders like 
you! See how to attend 
a panel discussion.  
See page. 4 

Welcome the new 
VAWPP    Coordinator, 
Lorraine Trippodi!  
Check out VAWPP 
Corner, page 5. 

Find out how to 
subscribe to our 
listserv  and contribute 
to our  newsletter.   
See page 5. 

Sneak Peak 
 

A Guide to What’s 
Inside 

Go to Format and 
select Align Text 
Vertically, and 

then select Center 
to have the text  

centered  
vertically in the 

box. 

If you wanted to move this box and the 
text within it together, you have to 

group them together.  Hold down Shift 
and click everything you want in the 

group.  In the lower-right corner of the 
selection box, click the Group Objects 

button. Now you can easily move,  
resize or rotate everything together.  

To ungroup objects, click the group to  
select it and then click Group Objects 

again.  

     “Man may have discovered fire, but women 
discovered how to play with it," says Sarah Jessica 
Parker’s character Carrie in one episode of the hit 
HBO series “Sex and the City.”  
     Sassy lines such as these are what keep viewers 
coming back for more as Carrie and friends dish 
about shoes, jobs, parties, and, most of all, their 
weekly sexual conquests. The show has received 
critical acclaim for its smart writing and unique 
characters. These women are so special, say many 
fans, because of their carefree, single-girl attitudes.   
     Successful in their respective professions, the 
“Sex and the City” girls cruise from relationship to 
relationship looking for, in some cases, a prospec-
tive husband, and in others, simple sexual 
satisfaction. These women, it has been said, are 
impressive examples of the woman of the new 
millennium. 
     This is today’s version of female empowerment.  
Was this, the power to shop all day for Jimmy 
Choo stilettos and sleep with whomever we choose 
then gab about it afterwards, the empowerment 
that the feminists of the past worked so hard to 
achieve?  
     While the sexual freedom of the characters in 
“Sex and the City” is relatively unique amongst 

women on television, who are very often only 
there to dote on a show’s male protagonist, the 
notion of passing this off as “empowering” is 
rather disturbing. The idea of economic freedom as 
evidence that feminism has reached its climax is 
one of the reasons that the feminist movement has 
lost so much momentum.  
     It is easy to point fingers and claim that the lack 
of popular support for a modern feminist move-
ment is the fault of middle-class white women and 
their general contentment with their status in 
modern American society.  
     The very nature of feminism, however, has 
made it susceptible to this loss of momentum. The 
movement has always been multifaceted, and the 
number of different groups, each working for its 
own issues, has made it difficult for feminists to 
present a united front. The problem is made even 
more complex in modern society where the 
obstacles that women face are less obvious to the  
general American population. Women have the 
vote. Title IX and similar acts have decreased the 
amount of blatant sex-based discrimination, even 
though the problem still exists. For many middle 
class women, the problem seems to be “solved.”  
     However, the economic empowerment that has 

(Continued on page 3) 

By Jennifer Dixon 

If your article  
continues on to another 

page, you can guide 
your reader there by 

adding a “Continued on 
Page.” Go to Format 

and select Text Frame 
Properties.  Under  

options, click 
“Continued on page” 
and it will be added 

automatically.  You can 
also use this to add 
“Continued from 

page.”   

If you have a text that you want to continue into 
another text frame, you can have the story flow 

into that text frame.  Click on the text frame 
where the story starts,  then go to Tools and  
select  Connect Text Frames.  The mouse’s  

arrow will change to a pitcher.  Then go to the 
text frame that you want the text to continue in.  
Click the pitcher on that text frame, and the text 

will automatically fill in. 

Example Page: 
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Under the File Menu: 
 
Save:  Make sure to save your work periodically.  There will be reminders that come up about 
every 20 minutes to remind you to save.  Click yes, you can never save too many times. 
 
Print:  It’s a good idea to print pages to make sure that the way your newsletter looks on the 
screen is the way you want it to look when printed.  It is also easier to pick up mistakes when you 
have the page in your hand.  However, to save paper, it is wise to print only the page you want  
instead of printing the whole publication.  To print only the page you want, select Print and under 
the Print Range select either the Current Page, or type in Pages From, the page you want to start 
on and finish on. 
 
Under the Edit Menu: 
 
Undo:  This tool will help you as you make mistakes along the way.  You can undo almost  
unlimitedly.  So if you make a mistake, just undo.  Go to the menu bar, select Edit, and select 
Undo.  Or use the key function Ctrl+Z.  Or use the button on the toolbar at the top of the screen.  
You can also redo, if you undo something by mistake. 
 
Cut, Copy and Paste: These tools make it easy to copy something you’ve created and move it to 
another place in the newsletter.  Use the key functions, Ctrl+X for Cut, Ctrl+C for Copy and 
Ctrl+V for Paste.  Or use the buttons in the toolbar at the top of the screen. 
 
Under the View Menu: 
 
Two-Page Spread:  This allows you to see two pages at a time, side by side. 
 
Hide Boundaries and Guides: You can choose to either show the boundaries and guides, 
which are the blue and red lines on the screen.  These are put there when you choose your layout 
guides.  These lines will not show up when you print the newsletter. 
 
Toolbars:  You can choose which toolbars you want to show up on the screen. 
 
Rulers:  You can choose to show or hide the rulers on the top of the screen and on the side. 
 
Wizard:  You can choose to show or hide the wizard.  The wizard is not usually helpful when  
making the newsletter, and it is usually better to keep it hidden. 
 
Zoom:  You can zoom in on a page up to 400% or zoom out to 10%.  If you hit F9, you can easily 
switch between a bigger screen and a smaller screen.  
 
Under the Insert Menu:  
 
Text File: This tool allows you to import text into the newsletter that you have saved somewhere 
else.  However, it is also possible to copy text from somewhere else and paste it into the  
newsletter.  
 

More Tools: 
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Picture: You can import a picture, either from clip art or from a file, into the newsletter.  
 
Design Gallery Object: You can import designs from Publisher’s Design Gallery into the 
 newsletter. 
 
Symbol:  You can select different symbols to use in the newsletter. 
 
Pages: This tool allows you to create pages in the newsletter.  When you select Pages, click on 
More Options.  Where it says Number of New Pages, put the number of pages you need.  The 
newsletter is usually six pages long. 
 
Font: This allows you to change the font.  
 
Character Spacing:  This is a feature that should be used with discretion.  Character spacing  
allows you to change the width of characters and the space between characters.  This is especially 
useful when a headline will not fit in a certain space or if you just want the characters in a word to 
be more spaced out.  However, if you use this feature too much, especially within the body of an 
article, it will end up looking strange when the newsletter is printed out.  
 
Line Spacing:  This tool allows you to increase or decrease the spacing between lines of text.  
This is a useful tool when you are trying to make text fit into a certain space.  However, you should 
also use this tool only when absolutely needed.  Otherwise, the text of an article will look strange if 
the spacing between lines is not uniform.   
 
Indents and Lists:  With this tool you can set indents for paragraphs.  You can also create  
bullets and numbered lists. 
 
Tabs: You can create your own tabs. 
 

D rop Cap:         That is a drop cap, which you can create with this tool.  Drop caps come only 
at the beginning of a paragraph.   
 
Align Text Vertically: With this tool you can align text within a text frame to be positioned at 
the  top, center, or bottom.  For example:   
 
 
 
 
AutoFit Text: This tool allows you to fit text into a certain space.  However, this is not  
recommended, since doing this will often change the font and size of your text.   
 
Line/Border Style:  This tool changes the width of lines and borders.  For example: 
 
 
 
 
 
 
 

Center 
Top  

Bottom 

  Hairline        1 pt.         2 pt.                   4 pt.                   8 pt. 
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Fill Color: You can fill spaces with different colors with this tool.  You can make a black  
background or a gray background and fill it with white text.  Creating different colors for  
backgrounds creates context within the newsletter and helps set off more important information. 
 
Shadow: This tool creates a shadow around an object.  For example:    
 
Text Frame Properties: This tool allows you to change the margins of a page.  It also creates 
“Continued on page” and “Continued from page” for your articles.  This allows you to guide you 
reader to the page where an article continues.  These “Continues” will only be added if you flow a 
story onto another page, which you will learn about with the Connect Text Frames Tool.                                  
 
Under the Tools Menu: 
 
Spelling: This tool checks spelling in the newsletter.   
 
Connect Text Frames:  When you can’t fit all the text of an article into one text frame, this tool 
will allow you to continue the text into another text frame, whether it be on the same page or a  
different page.   First, you must create an empty text frame for the text to flow into.  Then click on 
the text frame that holds the first part of the article.  Then select Connect Text Frames from the 
Tools menu.  Your mouse pointer will turn into a pitcher.  Finally, go to the empty text frame 
you’ve created and click on it with the pitcher.  The story will automatically flow into the text 
frame.  You can create “Continued on page” and “Continued from page” with the Text Frame 
Properties tool to guide the reader from the first part of the story to the other part of the story.   
 
Snap To Guides: Snap to guides are like magnets with your mouse pointer.  You have the choice 
to turn the snap to guides on or off.  If you set up layout guides or create guides from the ruler, 
your mouse will snap into place with the guides when you are creating text frames, objects or 
lines.  This can be useful if you want the page to follow your layout guide, but it can also get in the 
way if you want to create objects that do not follow the layout guides exactly.  You’ll learn about 
layout guides and making guides from the ruler next. 
 
Under the Table Menu: 
 
This menu is not used often, unless you make a table.  Tables usually are not needed in the  
newsletter.  But if you do create one, look under Help for instructions on how to use the Table 
menu. 
 
Under the Arrange Menu:  
 
Layout Guides: With this tool you can create guides that will aid you with creating the design 
for a page.  These guides can only be seen on the computer screen and do not appear when the 
newsletter is printed.  You can create as many columns as you want and as many rows as you 
want.  Therefore, when you are creating text frames and boxes, objects, lines, etc. you can use the 
guides to make sure the items on the page are straight, evenly spaced and balanced.  You can also 
change the margins of the page with this tool.  
 
Ruler Guides: You can create guides from the rulers on the top and left side of the screen.  
While holding down the Shift button, click on either ruler and drag the mouse pointer onto the 
page.  You will see that you’ve created a green line.  Just like the layout guides, this line is only 
seen on the computer screen.  To create horizontal lines, use the ruler at the top of the   
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page.  To create vertical lines, use the ruler on the left hand side of the screen.  To move the line 
once it is on the page, you must hold down the Shift button and click on the line.  The word 
“Adjust” will appear and you can then move the line anywhere on the page.   
 

 
Align: You can align objects on the page with this tool as they relate to the margins or as they  
relate to each other.         
 
Nudge:  You can nudge objects if you are having trouble moving them with the mouse.   
 
Rotate or Flip:  You can flip or rotate objects with this tool.  For example:  
 
 
 

 
Under the Mail Merge Menu: 
 
You will most likely never have to use this menu, but if you would like to find out about it, go to 
the Help menu. 
 
Under the Help Menu: 
 
Microsoft Publisher Help: Whenever you are in trouble, Publisher Help can provide  
assistance.  If you do not know how to use a tool or if you are confused, go to Publisher Help.  You 
can either search through the Contents or ask the Answer Wizard a question, and you will usually 
get the answer you are looking for.   
 
Show the Office Assistant: You can choose to show or hide the office assistant.  The office  
assistant comes in many forms, such as a paper clip, dog or robot image.  The office assistant will 
provide tips and you can click on it at anytime for help.  You can choose different office assistants 
by clicking on the present assistant, choosing options and then selecting the gallery.  Click the 
Back and Next buttons to scroll through the different assistants. 
 
Publisher Tutorials:  Use these tutorials to show yourself how to perform different functions 
that are confusing you, such as grouping and layering objects.  The tutorials are a great way to 
learn since they visually show you what to do. 
 

       Rotate Left      Rotate Right           Flip           Flip Vertical     Custom Rotate 
               Horizontal   

Bring to Front:   
Send to Back:                  
Send Backword: 
Bring Forward: 

These tools allow you to layer different objects on the page.  To bring an 
object all the way to the front or send it all the way to the back, click  
either Bring to Front or Send to Back.  Click Bring Forward or Send 
Backward to bring an object forward or backward one layer.  
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Here’s a step-by-step process to help you get started on the newsletter. 
 

First decide on the kind of design you want for you pages.  The best way to do this is on paper. 
You should have in mind what you want to put in the newsletter — how many articles, briefs, 
objects or anything else you might want to include. 

 
Fool around with Publisher.  Just try creating text frames, boxes, lines, etc. so that you feel  
comfortable with the tools.   

 
Now you’re ready to begin.  First decide if you want to create any layout guides or ruler guides.  
You can start off with some, and you can always change the guides later. 

 
Now time to create some text frames, since you cannot get text onto the page without them. 
 
Once you’ve created the text frames, you can start inserting articles and headlines.  The first 
headline you should do should be the banner across the top that reads VOICES, The Women’s 
Center Newsletter.  Over the years, this banner has stayed the same.  You should ask to see old 
Women’s Center newsletters to see how to create the banner, or see how you can improve on it.   

  
Then you should start inserting articles into the text frames.  You can either write the articles in 
Publisher or copy them from Word. 

 
If stories don’t fit, either cut them down or try making a new design to fit the stories into.  Also, 
remember that you can continue stories onto other pages by connecting text frames. 

 
A menu bar on the first page that tells the reader what is inside should be included.  This invites 
the reader inside the newsletter and sums up everything in the newsletter. 

 
Once you have the stories and headlines in place, start experimenting with borders and lines.  
Putting boxes around stories or lines on the page to separate stories can make a better page  

 design and help separate information.  However, it is not a good idea to box everything, and too 
many lines or boxes will start to look cluttered.  The idea is to keep the page simple, yet not  

 have the text of stories run into each other.   
 

At this point, you should have stories, headlines and any borders or boxes on the page.  Also,  
you might want to use gray shading in some areas, such as the menu bar and title banner on the 
first page.  However, too much shading will end up costing too much when the newsletter gets 
printed. 

 
The final touches can be placed on the newsletter.  Add any symbols or images you want to  
include in the newsletter.  Again, these should be simple.  Also, remember to include certain 
things that should appear in every newsletter.  The Calendar, the VAWPP (Violence Against 
Women Prevention Program) section and a box that contains information about the  

 employees, such as the Director, Associate Director, VAWPP Program Coordinator,  
 Administrative Assistant and you, the Editor.  Also, include the Women’s Center  
 phone number, e-mail address and hours. 

Getting Started: 

1 

2 

3 

4 

5 

6 

7 
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Here are a few ways to perform some functions faster, by using key functions or by clicking a but-
ton in the toolbar.   
 
To open a file:  Press Ctrl+O or click on the button that looks like a folder opening up. 
 
To save:  Press Ctrl+S or click the button that looks like a disk. 
 
To print: Press Ctrl+P or click on the button that looks like a printer. 
 
Cut: Press Ctrl+X or click the button that looks like a pair of scissors. 
 
Copy: Press Ctrl+C or click the button that looks like two sheets of paper and is next to the Cut 
button. 
 
Paste:  Press Ctrl+V or click the button that looks like a clipboard with a sheet of paper on it.  It is 
next to the Copy button. 
 
To Undo:  Either press Ctrl+Z or click the button on the toolbar that looks like an arrow curving 
downward to the left.  To Redo something, either press Ctrl+Y or click the button on the toolbar 
that looks like an arrow curving downward to the right.  (The undo and redo buttons are next to 
each other). 
 
Bring to Front: Press F6 or click the button that looks like three squares, with the yellow square 
overlapping the other two squares.  It is next to the Redo button. 
 
Send to Back: Press Shift+F6 or click the button that has three squares with the yellow square 
behind the other two squares.  It is next to the Bring to Front button. 
 
Custom Rotate: Click the button that has a green circle surrounded by a blue arrow moving in a 
circular pattern.  It is next to the Send to Back button.   
 
Zoom: You can zoom in on a screen either by hitting F9 or by going to the box in the toolbar at 
the top of the screen.  In the box, it tells what percentage the screen is at.  By clicking the arrow 
next to the box, you can select from other percentages.  You can also click on the buttons that look 
like a plus and a minus sign, next to the box, in order to zoom in and out. 
 
Publisher Help: Press F1 or click on the button that looks like a question mark. 
 
Connect Text Frames:  Click on the button that looks like a chain link when you want to  
connect a text frame.  First click on the text you want to connect, then click on the button.  The 
mouse pointer will change to a pitcher, with which you can pour the text into an empty frame.  
Once you have connected a text frame, the button that looks like a broken chain link will appear.  
You can use it to disconnect text frames. 
 
Style:  You can change the style of the text to body text, normal text or heading text, by selecting 
the styles in the box all the way to the left in the toolbar at the top of the page. 

Shortcuts: 
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Font: Change the font by selecting from the box next to the style box. 
 
Font Size:  Change the size of the font by selecting the size from the box next to the font box.  
Also, you can click on the buttons that look like a small A and a large A in order to decrease and  
increase font size. 
 
Bold:  Press Ctrl+B or click the button that looks like the letter B. 
 
Italicize: Press Ctrl+I or click on the button that looks like an italic I. 
 
Underline: Press Ctrl+U or click on the button that looks like an underlined U. 
 
Align Text:  You can align text to the right, left, center or you can justify it.  Click on the buttons 
that look like lines in a paragraph, in each of these alignment forms.  The buttons are next to the  
Underline button. 
 
Number: You can create a numbered list by clicking on the button that looks like a list numbered 
1, 2, 3. 
 
Bullets:  You can bullet a list by clicking the button that looks like a list with bullets. 
 
Decrease/Increase Indents: Click on the two buttons next to the bullet button.   
 
Fill Color: Click on the button that looks like a paint can dripping paint with a yellow stripe  
Underneath to fill a box or object with color. 
 
Line Color: Click on the button that looks like a paintbrush with a blue stripe underneath in  
order to change the color of lines to change the color of lines. 
 
Font Color:  Click on the button that looks like an A with a red stripe underneath in order to 
change the color of characters. 
 
Line/Border Style: Click on the button that has three lines, all different widths, in order to 
change the width of lines and borders. 
 
Text Frame Properties:  Click on the button that looks like a hand pointing to a sheet of paper.  
This will bring you to the text frame properties box.   
 
Rotate Left, Rotate Right, Flip Horizontal, Flip Vertical:  Click on the buttons that have 
triangles with arrows pointing to them.  
 
By clicking on the right side of your mouse you can bring up a menu that provides shortcuts for 
cutting, copying, pasting, deleting text, deleting objects, changing a frame, changing text and 
spelling and much more.  It is a quick, easy way to bring up a menu with a lot of functions without 
having to move your mouse. 
 
If you are having trouble figuring out which buttons go with what function, hold your mouse over 
the button, without clicking on it.  Within two seconds the name of the button will appear  
directly below your mouse pointer.  This way you know what all the toolbar buttons do. 
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Introduction: 

W elcome to the University of Connecticut’s Women’ Center.  As  

editor for the Women’s Center newsletter, you will have the responsibility of 

not only writing articles that discuss issues important to women at the  

university and all over the world, but you will also create the newsletter 

Using Microsoft Publisher.  Microsoft Publisher is software that creates  

newsletters.  By looking at the Women’s Center newsletters from Fall 2001 

and Spring 2002, you can see what a typical newsletter looks like.  This  

tutorial will help you navigate through Publisher if you have never used it  

before.  The tutorial will help you learn about the tools you will use in  

Publisher.  There is an example page with a sample newsletter.  Also, there are 

some steps for you to follow while creating the newsletter.  You will also learn 

about some shortcuts to help you create the newsletter faster and more easily.  

Creating the newsletter should be fun, and it will be once you familiarize 

yourself with this tutorial.  However, the best way to learn about creating the 

newsletter is experimenting with Publisher and learning through your  

mistakes.  Have fun! 
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led to "Sex and the City" style contentment for some women is not representative of the success of the 
women's movement as a whole - it is only a very small portion of what is 
yet to be achieved. The feminist goal of women becoming strong citizens by 
gaining responsibilities and freedoms equal to those of men has somehow, 
in today’s consumer culture, translated into the theory of purchasing 
power as the route to empowerment. The same middle class discontent 
that Betty Friedan explored in The Feminine Mystique seems as though it 
will inevitably resurface as more women realize that consumerism and the 
economic power that comes with it, which were once thought to be the so-
lution are, in truth, the problem. Happiness, represented today by the free-
dom to shop and spend, and empowerment, the true goal of the feminist 
movement, are not one and the same. This realization will be the most im-
portant step  
towards redefining the modern definition of feminism and forming a 
united feminist majority; two goals that have  
remained elusive to modern women for some time.  
     The growing trend of women utilizing their sexuality as a weapon and 
tool for getting what they want is well represented by “Sex and the City” 
and celebrities such as Britney Spears and Anna Kournikova. The attitude 
behind this trend is one of taking charge: women have been exploited by 
men for so long, that it is a step up for women to be exploiting themselves. 
Something incredibly degrading has miraculously disguised itself as a new 
form of empowerment. It is astounding that a movement once so opposed 
to consumer culture has managed to become integrated into the media and 
has, for many young women raised in this culture, lost its meaning. The 
feminist movement does not belong solely to the middle class white women 
that it has done so much for - if the movement is to survive and thrive in 
modern society, it’s most important issues will be ones not embraced by 
mass American culture.  
     “Sex and the City,” shopping, and sex appeal may be fun, but they are 
not as good as it gets, and it will not be until women begin to challenge the 
status quo and refuse to remain “comfortable” that they will realize how 
much can really be achieved. Modern society, in which many women be-


